Yaesu Transverter Sequencer in a Mini DIN

Rights & Permission
This document was created by Wayne Getchell of Sagacitic Solutions,
amateur radio call sign VE3CZO. It is meant for reference use. Do not
copy or publish it without permission and citation. If asked, permission is
easily obtained for not for profit use. Send your request to Wayne at

getch@sagacitic.com. If you want to use any part or all of it for profit let’s
talk.

Version
This document is for printed circuit board version 2.2

Overview & Features:
The key function of a transverter sequencer is to make sure the transverter,
and associated equipment, such as a transmit — receive relay or power
amplifier, have time to safely switch to transmit before RF power is applied.
Then, on switching from transmit to receive, the sequencer will also insure
RF power is removed before transitioning and provides a delay that is long
enough to prevent relay chattering during CW operation. This
microprocessor controlled circuit does that while fitting into the 8-pin Mini
DIN connector used with the Yaesu ACC port. This sequencer has the
following function and features
e Uses the ACC Tx-Gnd open collector output to sense a request to
change state between transmit and receive.
o On changing state from receive to transmit, it drives the PTT output
while also creating a programmable delay (StartDelay) that inhibits
RF power by controlling the TxInh pin until the system has had time
to switch.
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o On changing state from transmit to receive, it provides a delay
(Hangtime) extending the transition to avoid excessive Tx/Rx relay
switching during CW operation. After Hangtime expires the PTT
state is changed. Four default Hangtimes are provided in the
firmware. These delays are programmed as defaults in the
firmware and can be selected at build time dependine on the mode
being used and CW speed. 25 ms is used for SSB or digital
modes, 300 ms is recommended for code speeds greater than 30
words per minute, 650 ms for code speeds greater than 15 words
per minute and 1000 ms for code speeds greater than 10 words per
minute.

e The PTT output is an open drain configuration that, during assembly,
can be populated as either high or low during transmit.

e StartDelay is programmable and defaults to delaying TxInh for 25 ms
after PTT changes state when transitioning from receive to transmit.

¢ Hangtime delay can be selected to be 30, 300, 650 or 1000
milliseconds by shorting solder jumpers when populating the PCB.

e Provides pins for TxD, RxD, and GND at the rear of the PCB to allow
easier connection to external rig controllers through the Mini DIN
connector.

e Operates over a wide voltage range, six to fifteen volts, and uses
minimal current, about 1.5 mA.

Important Note:
This controller provides only two delay times, one while transitioning from
receive to transmit and a longer delay when transitioning from transmit to
receive. If your set-up requires a multi-stage sequencer, for instance,
removing power to a pre-amp then keying the transceiver then enabling a
power amplifier, the additional delay sequences must be done elsewhere.
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Circuit Description
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Mini DIN Sequencer V2.2 Circuit Schematic

Hardware
The circuit is powered by the ACC port’s 13.8V supply pin.
A MCP1703 five volt low drop out regulator U2 provides the supply voltage
for the microcontroller. C3 and C4 provide bypassing for the regulator to
insure its stability.
U1, an Atmel ATtiny45 processor in an 8 pin small outline package, is the
heart of the controller. This micro has six I/O pins and the design uses 4 as
inputs and 2 as outputs.
Pins 2 and 7 are programmed as outputs. Pin 2 (PB3) drives the gate of Q1,
a 100 Volt 3 Amp N channel FET. The drain of this device is the Push to
Talk (PTT) output. C1is an RF bypass capacitor. Pin 7 (BP2) connects to
the ACC pin 2, Tx-Inh. Tx-Inh is used to prohibit or enable the transceiver’s
RF output.
Pins 1, 3, 5, and 6 are programmed as inputs. Pin 1 (PB5) is programmed
as an analog input, and is connected to a voltage divider formed by R1 and
R2. The voltage at pin one determines whether the PTT output is active
high or low. If R2 is not installed, the voltage at Pin 1 will be five volts and
active low is used. If R2 is present it lowers the voltage measured at pin 1
and active high is used. Pin3 (PB4) and pin 5 (PB0) are configured as
inputs with internal pull-up’s enabled. The two inputs are programmed to
form a two bit binary word with PB4 set as the most significant bit. Together
they are used to select Hangtime. If jumpers JO or J4 are left open the
internal pullups will take the inputs high, if the jumpers are soldered closed
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the inputs are held at ground. Hangtime delays are programmable. The
default values chosen are:

JO J4 Hangtime (ms)
Open Open 25
Short Open 300
Open Short 650
Short Short 1000

Pin6 (PB1) connects to the ACC port’s TX-GND pin (pin2) and is used to
sense a request to transmit. The input is configured with its internal pull-up
on so is high until the TX-GND pin is pulled low by the transceiver.

Solder pads are provided on the PCB so that in circuit serial programming
can be used to program the processor. Separate documents are provided
describing the wiring hook-up and programming procedure.

Firmware
The ATtiny uses the Arduino programming environment. Install a copy of
the Arduino integrated design environment and load the sequencer ino file
into it to follow along as you go through the firmware description.

Circuit Schematic version 2.2
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Inputs
1. TX-GND on PB1 - senses a request to transmit high= key-up or RXx,

low=key-down or Tx.
2. Jumpers JO on PBO and J4 on PB4 set hangtime during initialization
3. Analog voltage on PB5 is used to sense whether PTT is active high or
active low. R2 (33k Ohms) must be installed for active high.

Outputs
1. PTT on PB3 — an open drain is used to indicate transmit or receive state

to the connected transverter. If active low is selected high, or off = Rx;
low, or on =Tx. Opposite is true if active high.
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2.

Tx-Inh on PB2 — inhibits RF output power from a connected transceiver
when high, and enables transmit power through the setup when low

Notes on Routines & Variables

1.

Setup
. The voltage at PB5 is measured. If <= 3.5V, but higher than digital LOW,

o o

The ‘elapsedMillis’ routine is used to allow input state changes to be
monitored while the StartDelay or Hangtime is being counted in the
background.

The variable ‘StartDelay’ is used to hold back RF power until the
transverter has had time to safely switch from receive to transmit.

The variable ‘Hangtime’ is used to prevent the transverter from changing
states from transmit back to receive in between Morse characters.
Hangtime selected will depend on the user’s code speed. A Hangtime of
25 ms is provided for digital or SSB work, and it is the ‘default’ i.e. both JO
and J4 are open.

R2 (33k Ohms) is installed so PTT transmit mode is set to active high
otherwise the measured voltage without R2 will be at the supply voltage
and the transmit mode will be set to active low. The PTTState is initialized.
Inputs PBO and PB4 form a two bit word used to select the hangtime from
four possible options. These digital inputs have their pull-ups enabled so if
the jumpers attached to these inputs are open the input will be high, if
soldered short to ground the input will read low. PB4 forms the MSB. A
switch routine is used to select the hangtime.

To minimize current consumption after initialization, the internal pull-ups
and the analog converter are turned off.

. Tx-Gnd is monitored and the program loops until TxGnd goes (or is) low.

PTT is toggled and routine monitors for a TxGnd state change while
waiting for the StartDelay to expire. If TxGnd changes before StartDelay
expires the StartDelay timer is reset.

StartDelay expires (TxGnd has remained low for StartDelay), so TxInh is
taken low to enable RF through the system

The firmware monitors Tx-Gnd for a state change to high, indicating
request to transition from Tx to Rx (key-up).

When a Tx-Gnd high is sensed, the Hangtime counter is started.

If Tx-Gnd goes low during the hangtime (key-down sensed), the Hangtime
counter is reset.

If Hangtime expires, TX-GND has been high for longer than the Hangtime,
so TxInh is taken high, preventing RF from entering the system, then after
a short delay, the PTT state is toggled into the receive state.

The firmware loops back to the beginning of the loop routine and waits for
TX-GND to go low.
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Timing Measurements

In the following scope trace records, trace 1 is the sequencer’s PTT output,
trace 2 the TxInh output to the ACC connector pin 8, and trace 3 is TxGnd
input from the ACC connector pin2.
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StartDelay is programmed to be 25ms. PTT is active high. The
transceiver’s TxGnd open collector output goes low indicating a request to
transmit. PTT goes hi telling the transverter to set up for transmit mode,
and TxInh delays RF output from the transceiver for 25 ms giving the
transverter time to change state to transmit before RF is allowed though the
system.
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Hangtime delay is programmed to be 25ms. PTT is active high. The
transceiver’s TxGnd open collector output goes high indicating a request to
return to the receive state. Hangtime delays the start of a transition to
receive for 25 ms. At that time TxInh goes high disabling the transceivers
RF output. A further delay of 5 ms is built into the system to insure that
TxInh always inhibits RF before the transverter is allowed to switch state
back to receive. After the further 5 ms delay, PTT goes low, allowing the
transverter to switch to the receive state. The 5 ms delay is arbitrary. It
insures that TxInh always precedes PTT to insure that there is no RF in the
system when PTT commands the transverter to change state back to
receive. If TxGnd is re-triggered before TxInh goes high the Hangtime
delay is extended until TxGnd once again goes low. If TxGnd is retriggered
after TxInh goes high, a StartDelay is invoked. The 5 ms delay is the same

for all Hangtime and therefore has the most impact with the 25 ms

Hangtime making it 30 ms
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FT-817 Transverter Sequencer
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Assembly Guidelines
Start by dry fitting the PCB in the Mini DIN connector. It's a tight fit and the
PCB was Vcut so the edges are not as precise as routing would be. As a
result the PCB may be just a bit longer and wider than desired. The PCB
must NOT extend past the end of the metal shield surrounding the DIN
connector.
Disassemble the 8 pin Mini Din connector. The Mini Din has 3 rows of pins,
2 pins in the first row (1, 2) and a second and third row of three pins (3, 4, 5,
&6,7,8).
Fit the PCB into the DIN connector pushing it all the way into the connector
while aligning it carefully between the first two rows of pins with pins 1 and
2 to the PCB bottom and 3, 4, 5 to the PCB top.
Place the metal shield around the PCB and check for clearances. If the
board is too long or wide, file a bit off the PCB like the image below which
shows a PCB before and after filing. Be careful not to cut into the pads.
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Populate all the components on both sides of the PCB. As the PCB is
small, there wasn’t room to provide identification for all components on the
silk screen, so use the PCB top and bottom layouts below to identify part
locations. The PCB top side has three Mini DIN solder pads. The bottom
has two.

Components are fairly tightly packed on this board, and when they share a
common connection area solder pad like C2 and R1, soldering can be a bit
tricky as the solder tends to spread into the adjacent component’s pad area.
For best results solder the end of the component that abuts the already
installed component first.
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RxD Out

SP9
LU e ) Pin4 TXD
SP11 SP3

3 _°[y o
1. Install all top side components

1 U1 ATtiny45-20XU - Solder pin 4 first. Align the device
for best fit then solder pin 8 followed by the remaining pins

1 JO Solder jumper short if Hangtime is to be 650 or 1000
ms

2Tx " P14 L3RG ooy SP13

Sp2 1 v PTT
Pin2 TX-GND N

SP1
Pinl 13.8V

2. Install all bottom side components
1 R1 22k0
1 R2 33k0 -install only if PTT is active high
1 C3 1uF 25V MLCC
1 C4 1uF 25V MLCC
1 C2 100nF 50V
1 J4 Solder jumper short if Hangtime is to be 300 or 1000
ms
Q1 SSM3K361R Nch MOSFET
C1 1nF

O O
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1 U1 MCP1703AT-5002E
1 Program the microcontroller if it is not pre-programmed

3. Carefully inspect the PCB soldering for bridges or incomplete solder joints
especially on U1 and the jumpers.

Assembly & Test
Again fit the Mini DIN connector and
PCB together pushing the PCB all
the way into the connector. Solder
pin 4.
Check PCB alignment to the
connector. The PCB must be
centered and placed tightly against
the Mini DIN connector’s body.
Place the connector and PCB in the
Mini DIN metal shell and check
alignment. The fit is tight so there
isn’t much room for misalignment. Adjust the PCB location if necessary to
make sure it fits within the Mini DIN’s metal surround casing.
Solder the remaining Mini DIN pins to the PCB and check to insure there
isn’t any solder bridging between the PCB pads or Mini DIN pins.
Strip the insulation from the piece of 30 gage wire-wrap wire and solder Pin
8 of the Mini DIN connector to the SP8 solder pad on the PCB.

] Wire soldered from SP8 to Mini DIN pin 8
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Functional Verification Testing
These initial tests insure that there are no short circuits that could damage the
transceiver’'s ACC port. A multimeter with probes capable of probing the
sequencer PCB will be required for these tests.

b.

a. Measure the resistance between SP1 marked 13.8V with the
meter’s positive probe lead and SP12 marked Gnd. Because of the
capacitors in the supply line and the voltage used on resistance
range of the multimeter the reading may start off in the kiloohm
range but with a few pokes it should go very high, in the megaohms
range.

1 SP1toSP12resistance ___ ohms.

Measure the resistance between SP2 marked Tx-Gnd with the meter’'s

positive lead and SP12 marked Gnd. It too should be very high, in the

megaohms range.

(]  SP2to SP12 resistance ohms.

Check that the voltage regulator is working. For this test a variable voltage
source is required as well as a multimeter.

a)

Attach the variable voltage source to the PCB by solder jumper wires
onto the PCB side of the Mini DIN 13.8V pin (pin 1) and ground at
SP12. Set the voltage source to 5.0 volts and apply power to the
circuit. Using the multimeter, monitor the voltage between ground and
the 5V solder pad SP14. The voltage should be 5.0 V +/- 0.15V

1 SP14toGndvoltage ___ volts.

Increase the supply voltage to 5.5 volts. The voltage at SP14 should

stabilize at 5.0 V +/- 0.15V

1 SP14toGndvoltage ___ volts.
Increase the supply voltage to 6.0 volts. Record the 6.0 volt reading
and calculate the difference in voltage between the 5.5 and 6.0
measurements. It should be less than 0.05 volts. If the voltage
increases more than 0.1 volts, do not go further or the microcontroller
will be damaged. There is something wrong with the voltage regulator
that must be fixed before proceeding any further.

1 Reading with 6.0 volts applied volts.

1 5.5t0 6.0 voltage difference _____ volts.
Increase the supply voltage to 15.0 volts. The voltage at SP14 should
not vary by more than 0.15V from the 6.0 volt reading.

1 6.0 to 15.0 voltage difference volts.

The following tests will verify that the circuit is switching correctly but of
course can’t assess the delays. This test will use the FT-817 in both receive
and transmit mode. When placing the transceiver in transmit mode, any
power or band will do. The easiest way to make the FT-817 transmit
continuously is to use the PTT switch on the microphone. You will also need
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a power supply for the transverter with an output voltage of between 12 and
14 volts, a dummy load, and a multimeter with a probe lead capable of
probing the sequencer PCB terminals, and a leaded resistor. Any quarter or
half watt resistor with a value anywhere between 1,000 and 10,000 ohms will
do.

Tack solder one end of the resistor to the PTT solder pad SP13. Connect the
other end of the resistor to the positive terminal of the external power source.
Place a dummy load on the transceiver's RF output.

Plug the Mini DIN sequencer assembly into the transceiver’'s ACC socket.
Connect the multimeter ground to any convenient ground point on the
transceiver.

Connect the transceiver to the external power source.

Turn the transceiver on and keep it in receive mode. For measuring
convenience turn the rig upside down.

a. Measure and record the power supply voltage when the transceiver
is transmitting. This voltage will be used as a reference for other
measurements

"1 Power supply voltage during Tx ____ V.

b. Measure the voltage at SP1 marked 13.8V, that’s also Pin 1 of the
Mini Din connector. It should be within 0.75 volts of the power
supply voltage

1 SP1voltage ____ V.

c. Measure and record the voltage at SP14, the output of the five volt

regulator. It should be 5 volts +/ 0.15 volts.
17 SP14 voltage __ V.

d. Measure the voltage at SP13 PTT. If the sequencer is configured
for PTT active low the measured voltage should be within 100 mV
of the supply voltage. If the sequencer is configured for PTT active
high, the voltage should be less than 100 mV.

7 SP13PTTvoltage _____ V.

e. Measure the voltage at Tx-GND pin 2 of the Mini DIN connector. It
should be within .05 volts of the voltage measured at the output of
the 5 volt regulator.

1 TX-GND pin2voltage _____ V.

f. Using the microphone PTT switch place the transceiver in transmit
mode and measure the voltage at Tx-Gnd pin 2 of the Mini DIN
connector. It should be under 100mV.

] TX-GND pin 2 voltage intransmit ____ mV.

g. With the transceiver again in transmit mode and measure the
voltage at PTT SP 13. If the sequencer is configured for PTT active
low the measured voltage should less than 100 mV. If the
sequencer is configured for PTT active high, the voltage should be
within 100 mV of the supply voltage.

1 PTT SP13 voltage in transmit V.



Place the transceiver in receive mode. Turn the transceiver right side up for
measuring convenience.

h. Measure the voltage at SP8 TxInh or Pin 8 of the Mini DIN
connector. It should be within 50 millivolts of the voltage measured
at SP14

1 SP8voltage ___ V.
i. Place the transceiver in transmit mode and measure the voltage at
SP8 marked TxInh. It should be under 100mV.
1 SP8voltage intransmit ____ mV.
Turn the transceiver off and carefully remove the Mini Din plug & PCB
assembly by wiggling it out of the socket. Unsolder the resistor from the PTT
solder pad and remove it.

Final Assembly
In the following steps install the push to talk control cable of your choice that
will connect the sequencer to the transverter’s push to talk input.
Place the 15mm long 7mm diameter piece of heat shrink and the Mini DIN
outer shell over the end of the connecting cable.
Solder the cable’s positive lead to SP13 (PTT), and negative lead to SP12
(GND).

If rig control is to be used solder its cable leads to the SP9 the TxD Ouit,
SP10 RxD Out, and SP11 Gnd, pins on the sequencer PCB.

It's a good idea just to check the cable continuity before assembling the
connector.

Complete the assembly of the Mini DIN connector.

Slip the 15 mm length of 7mm diameter heat-shrink over the PCB assembly
to prevent any possible shorts to the Mini DIN’s metal case. Install the Mini
DIN’s metal shield around the connector and PCB assembly then place the
plastic case parts over the connector. Push the Mini DIN cover part way
over the assembly. Insert the Mini DIN into the ACC socket then push the
cover onto the connector so that it is just shy of the rear panel. Don’t push
it too far on or it will become difficult to near impossible to disassemble the
connector if needed.

Notes about driving higher current loads and relays with the PTT output

1. The PTT drain output is an SSM3k361 Nch MOSFET rated for a maximum
100 volts Vbss and a maximum drain current of 3.5 amps so should be
robust for most applications. It does have a maximum on resistance of 95
milliohms when driven from the five volt processor so when driving high
current loads do keep in mind that it’s a tiny SOT23 device. Power
dissipation should be limited to under 0.75 Watts, and to do this the
maximum drive current should be kept to under one amp.
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2. The PTT drain has no transient protection so when driving inductive loads

like relays, transient protection must be provided externally.

3. With PTT active high applications note that there is no internal bias supply
for the drain. To make the output high, a bias must be supplied from
external circuitry. When active hi (in transmit) the PTT drain will be open

circuit. In receive, PTT will be driven to ground.

FT817 Mini-DIN Sequencer

Qty Value Device
Resistors
1 22k0 RESISTOR 1608 (0603) 1%
1 33k0 RESISTOR 1608 (0603) 1%
Capacitors
1 1nf CAP_NONPOLARIZED 1608 (0603) 5% NPO 50V
1 0.1uF CAP_NONPOLARIZED 1608 (0603) 10% X7R 50V
2 1uF 25V CAP_NONPOLARIZED 1608 (0603) 10% X5R 50V

IC's & Transistors
1 MC1703AT MCP1703AT-5002E/CB
1 SSM3K361R,LF Nch SOT23-F 100V 3.5A 1V VGSth range
1 ATTINY45-20XU ATTINY45-20XU

Enclosure, Hardware, Connectors & Other Parts

1 PCB 15.5x 6.5 x1.2 mm

1 interconnect wire 2cm 30ga wire wrap wire
1 heat shrink 7mm dia. X 15 mm long
1 8pin Mini-DIN Male in-line connector
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Part ID

R1
R2

c1
c4
c2,C3

Source

Digi-Key
Digi-Key

Digi-Key
Digi-Key
Digi-Key

Digi-Key
Digi-Key
Digi-Key

VE3CZO
VE3CZO
eBay

Digi-Key

Part No. or Vendor ID

RMCF0603FT22KOCT-ND
RMCFO0603FT33KOCT-ND

311-1080-1-ND
1276-1000-1-ND
490-16608-1-ND

MCP1703AT-5002E/CBCT-ND
SSM3K361RLFCT-ND
ATTINY45-20XU-ND

hifispot168
CP-2080-ND



»

(T/1 :399YS) UYdS""ZA 49ousnbas NIQ-IUIW £T814\490usnbas NIQ-IUIW £T1814\s309[04d\0 £ '£-319VA\:D ST'T=4 TH:ST TZ-bNv-10 &

2

o 7 g 7 ¥ (3 4 T
/7 7 P+iST TZ-Dbny-71@ iaaeq SwpERT * *
B N . SwpG9 *
zznin3y 0ZJ€3N :4ouny upaz x
. . sSwGZ
Z'Zn 49duanbas NIQ-TUTW £T814 9114 (sweunbueH  @r  be :
(parJoys sodwnl=x) swnbuey ssbueys gr 4o br saodwnl buniioys
||_\H .\_H\/X ZHD|._”F|_._”_)_ Fl_._”ﬁ_ m Zd 11BISUT 10U Op MOT 3ATIDE ||d OYEE Zd TIBISUL 1Y 8ATDE | |d (E
! ! ! aN1g Ul umMoys sJaqunu utd ouINpJY (Z ||
‘A[eu4o1xa pappe aq isnw ) jibutwwesboud uaym 18584 uo ded ay 18buoy 1 uoQg
'n8< 99 isnuw +n boud ‘pas uUT uUMOys ¢SI] 403 SUOTIDSUUO] (T
Sa10N
3
axy guid 87dS
Gds N0 axd
axl +uid 6dsS
+dS N0 dxL
d
ang 77dS
ang pug
aN9 gutd wmm_w —
€dS B
Sas N9 N9 Bod
nxez-syhuniy 1—\ anNg 3
ISOW : : wwes
9ds | ISOW boid R R [ p
0SIuW bo.d 1 zad ead [SZ pr
»3s boid <4 550 cag [&-&
ON9-XL1 Zuild 8 T8 ]
¢ds aNe oizz N £ 10N S
HNI-X1 8uld ang g
8ds 32005-1YE€0LTdoN = o] h_r_@_®_._u NW i 9]
c N 434/0N9 o “ 1sy _--HM R .
N8'€ET TUld ._._I_I N 23 2ds AT9EAENSS ||
Tds N NI LNON a4 NG 154 boud )\ €7dS
+n boud g $TdS L1d
zZn
2 g ¥ [ 4 T




15.59%x6.5%x1.2

SP10@ .
RxD Out Pin5 RXD

Pin8 Tx—INH
0SI TXiFI]NH xﬂl‘ U2.2
~ sp4
DT tiny45- Pin4 TXD

SP11 SP3
Gnd U1 3 Pu GND

SPS
TxD Out

| 5u sp14 C3R
EA =

Pin2 TX-GND

SP1
Pinl1 13.8UV

230



ATTiny Programming for the Mini DIN sequencer using an Arduino Nano
As the ATtiny doesn’t have a communications port programming in with the Arduino IDE is a bit
more complicated than simply plugging in a USB connector. The In Circuit Serial Programming
(ICSP) port will be used for programming.
1. Program the Arduino Nano as an ISP programmer
a. Attach a Nano to the computer via USB cable. Do NOT connect the Nano to any
other circuity at this point or you’ll likely get programming errors.
b. Download and / or open the Arduino IDE. The Download can be found here:
https://www.arduino.cc/en/software

c. Navigate to ‘File’ then ‘Examples’ then ‘ArduinolSP’ then move the mouse right
to reveal ‘ArduinolSP’ option and select it to load the program.

i. Asthe wiring to the ATtiny is a bit of a rats nest we will modify the
‘ArduinolSP’ script to use a lower programming speed, i.e. 128k. This
speed will also work when programming a device for any clock speed, it
simply slows down the programming rate and may be useful with the
additional lead lengths needed to connect the sequencer to the
programmer.

ii. Navigate to the ‘Configure SPI clock (in Hz.)’ section of the sketch.
Uncomment the line #define SPI_CLOCK  (128000/6)

iii. Comment out the line #define SPI_CLOCK (1000000/6)
iv. This changes the programming rate from 1MHz to 128 kHz

ArduinolSP §
g#¢define PROG_FLICKER truse

// Configure SPI clock (in Hz).
// E.g. for an ATtiny @ 128 kHz: the datasheet states that both the high and low

// SPI clock pulse must be > 2 CPU cycles, so take 3 cycles i.e. divide target
// £_cpu by 6&:
¢define SPI_CLOCK (128000/8)

!/
i

// A clock slow enough for an ATtiny85 @ 1 MHz, is a reasonable default:
//#define SPI_CLOCK {1000000/6)
d. Navigate to the ‘Tools’ menu then ‘Board:’ then ‘Arduino AVR boards’ and select
‘Arduino Nano’

e. Again navigate to the ‘Tools’ menu then ‘Processor’ then select ‘ATmega328P’
Note if this fails to program correctly you may have an older boot loader in
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which case go back to the ‘Tools’ ‘Processor’ and select ‘ATmega328P (Old
Bootloader).

f. Again navigate to the ‘Tools” menu then ‘Port:” and make sure the correct com
port is selected.

g. Program the Nano. Navigate to the right arrow in a circle icon near the top of
the screen and select it or navigate to the ‘Sketch’ menu item then select

‘Upload’
2. Put together a programming jig. Solder pads are provided on the sequencer PCB for
wires that can be connected as indicated in the table -
, 6 pin IDC
below. Keep the wire lengths under about 10 cm. It’s 1
2

convenient to use a solderless breadboard as a host for the

Nano and wires but not absolutely necessary. The Nano MISOI e
ICSP header can also be used instead of the D pins with the

Vcc

SCK MOSI
exception of the reset pin which must be connected to D10 9e

on the Nano. Don'’t forget to add a 10 uF capacitor from RST I ® @ |cno
RST (+) to Gnd (-) on the Nano. 5 6 ‘
Function ATtiny Sequencer Nano Pin Nano ICSP 6 pin
physical pin Solder Pad header
Reset 1 SP7 D10 D10 (not on ISP)
MOSI 5 SP6 D11 4
MISO 6 SP2 (DIN Pin2) D12 1
SCK 7 SP8 (DIN Pin8) D13 3
V+ 8 SP1 (DIN Pin1) 5V 2
GND 4 SP11 or SP12 GND 6
10uF cap RST to Gnd

3. Prepare the ATTiny 45 for programming with a bootloader
a. Download the ATTinyCore to add these boards to the boards manager
i. Click on ‘File’ then ‘Settings’
ii. Inthe ‘Additional Boards Manager URLs:’ section near the bottom of the
window paste the following link
iii. http://drazzy.com/package drazzy.com index.json
iv. Click on ‘OK’
b. Click on ‘Tools’ then ‘Board: ‘Arduino Nano’, then right and click on ‘Boards
Manager’
In the ‘Filter your search...” at the top of the window type in ‘ATTinyCore’
Click on the ‘ATTinyCore window area.
Close the ‘Boards Manager’ window.
Click on ‘Tools’ then ‘Board: ... and navigate to ‘ATTiny Core’

-~ o a o0

232



g. Select ‘ATtiny 25/45/85’

h. Clock on ‘Tools’ then ‘Chip: ..." then navigate to and select ‘ATtiny45’

i. Clickon ‘Tools” then ‘Clock: ...” then navigate to ‘1MHz internal’

j. Leave other menu items in the ‘Tools’ section in their defaults.

k. Click on ‘Tools’ then ‘Port’ and check that the correct port is still selected.

I.  Click on ‘Tools’ then ‘Programmer’. Navigate to and select ‘Arduino as ISP

(ATTinyCore)’
Load the Mini-DIN sequencer sketch

a. Click on ‘File’ then ‘Open’

b. Navigate to and select the ‘Sequencer for Ver2.2 hw_V2.2a.ino’

c. Make any desired changes to the StartDelay or Hangtime but if you do make

changes save the file with a different name.
Add elapsedMillis to the Arduino library

a. Under the ‘Tools’ menu click on ‘Manage Libraries’

b. In the library manager search for ‘elapsedMillis” and install the latest version
Click on the ‘Tools’ menu and check that all the options for board, chip, clock speed, and
port are still valid.

Burn the Bootloader and then the sequencer sketch
a. Click on the ‘Tools’ menu then select ‘Burn Bootloader’
b. Upload the sketch using the right arrow in the circle in a menu near the top or
click on ‘Sketch’ then ‘Upload’
Unsolder all the programming leads from the sequencer and try it out!
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